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1 Introduction

1.1 Version History

This guide is regularly reviewed and updated. All suggestions for improvement are welcome.

The original language of this guide is English.

Table 1: Version History

Version Remarks

AB501135116041, version 0101 First release

1.2 Purpose of this Application Guide

This application guide is intended for qualified personnel such as:

l Automation engineers.

l Commissioning engineers who have experience of operating with parameters and basic knowledge of the iC7 drive.

l The engineers must have knowledge with Rockwell Automation® Studio 5000®.

This application guide provides information about how to integrate the Danfoss iC7 drives into the Studio 5000® designer tool. The

designer tools includes Studio 5000 Logix Designer® and Studio 5000 View Designer®. The add-on instruction and add-on graphics

(faceplate) are not protected and can be modified to serve the specific requirements by the end-user.

Danfoss takes no responsibility for losses due to code faults in these function blocks or for wrong use.

This application guide does not include:

l A description of the Allen-Bradley® equipment and Rockwell Automation® programming tools that are necessary to handle the

application.

l Other tools from Rockwell Automation® which are needed for large-scale applications.

NOTE: Refer to the Rockwell Automation® programming and operating guide for further information.

1.3 Additional Resources

Additional resources are available to help understand the features, safely install, and operate the iC7 products:

l Operating guide iC7 Series EtherNet/IP OS7IP.

l Safety guides, which provide important safety information related to installing iC7 drives.

l Installation guides, which cover the mechanical and electrical installation of drives.

l Design guides, which provide technical information to understand the capabilities of the iC7 drives for integration into motor

control and monitoring systems.

l Application guides, which provide instructions on setting up the drive for a specific end use.

l Other supplemental publications, drawings, and guides are available at www.danfoss.com.

Latest versions of Danfoss product guides are available for download at https://www.danfoss.com/en/service-and-support/

documentation/.
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1.4 General

Configuration examples and illustrations made in this guide are based on the default settings of the drive. Special parameter settings to

fit the current application are possible, but may conflict with the information provided in this application guide.

1.5 Abbreviations and Acronyms

Term Definition

ACD Application code definition

AOI Add-on instruction

AOG Add-on graphic

CPU Central processing unit

CTW Control word

EDS Electronic data sheet

HMI Human machine interface

JSR Jump to subroutine

MAV Main actual value (Process value)

PV Process value (Main actual value)

REF Reference (Setpoint)

SP Setpoint (Reference value)

STW Status word

UDT User-defined types

1.6 Trademarks
l MyDrive is a registered trademark of Danfoss A/S.

l Rockwell Automation Studio 5000 is a registered trademark of Rockwell Automation, Inc.

l Studio 5000 is a registered trademark of Rockwell Automation, Inc.

l Studio 5000 Logix Designer is a registered trademark of Rockwell Automation, Inc.

l Studio 5000 View Designer is a registered trademark of Rockwell Automation, Inc.

l PanelView is a registered trademark of Rockwell Automation, Inc.

l CompactLogix is a registered trademark of Rockwell Automation, Inc.

l ControlLogix is a registered trademark of Rockwell Automation, Inc.

l GuardLogix is a registered trademark of Rockwell Automation, Inc.

l Allen-Bradley is a registered trademark of Rockwell Automation, Inc.

l Allen-Bradley GuardLogix is a registered trademark of Rockwell Automation, Inc.

l Allen-Bradley PanelView is a registered trademark of Rockwell Automation,Inc.
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1.7 Disclaimer

The add-on instruction and add-on graphic is provided "as is" without warranty of any kind, expressed or implied, including, but not

limited to, the warranties of merchantability, fitness for a particular purpose, and non-infringement. In no event must the authors or

any legal entity part of the Danfoss group be liable for any claim, damages, or other liability. Whether in an action of contract, tort, or

otherwise, arising from, out of, or in connection with the software, or the use, or other dealings in the software.
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2 Safety

2.1 Safety Symbols

The following symbols are used in Danfoss documentation.

  DANGER

Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

  WARNING

Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

  CAUTION

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

  NOTICE

Indicates information considered important, but not hazard-related (for example, messages relating to property damage).

The guide also includes ISO warning symbols related to hot surfaces and burn hazard, high voltage and electrical shock, and referring to

the instructions.

ISO warning symbol for hot surfaces and burn hazard

ISO warning symbol for high voltage and electrical shock

ISO action symbol for referring to the instructions

2.2 General Safety Considerations

The end-user is responsible for addressing any regulatory requirements to the installation. Refer to the iC7 Design Guide for further

information of the mechanical installation considerations.

  WARNING

POTENTIAL DAMAGE TO SYSTEMS

Some parameters in system configuration can significantly change the system response and even make the system non-

functioning. Potential damage to other systems, for example motor, or other components related to motor control can occur if the

parameters are not set correctly.

l Make sure to understand the parameters fully before changing any of the parameters in the drive.
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3 Commissioning

3.1 Introduction

The section covers how to integrate a Danfoss iC7 drive into a Studio 5000 Logix Designer® project by the use of a provided ESD file. The

process involves installing the ESD file, configuring the EtherNet/IP connection, and verifying communication. Furthermore, it shows an

example of how to configure custom process data (input/output) for the Danfoss iC7 drives in Studio 5000 Logix Designer®.

NOTE: The examples in this application guide are based on Allen-Bradley® GuardLogix® controller firmware revision 36

and Allen-Bradley® PanelView™ HMI firmware revision 9.

3.2 Network Configuration
To identify the products and easily commission them on a network, an electronic data sheet (ESD) file is needed for the iC7 drive.

1. Download the ESD file from the website Fieldbus configuration files | Danfoss.

The downloaded file contains a compressed zip file with all the released ESD files for the different iC7 applications.

2. Save and extract the zip file locally on a computer.

The computer must have Rockwell Automation® Studio 5000® installed.

3. Start the windows application Device Description File Installation Tool in the start program folder named Rockwell.
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Figure 1: Device Description File Installation Tool

Alternatively, start the tool from the software application Studio 5000 Logix Designer® from the menu bar Tools, select

Device Description Installation Tool in the drop-down menu.
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Figure 2: Device Description Installation Tool (Optional)

4. Register the device by following the registration wizard of the tool.
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Figure 3: Register a Device Description File

5. Add the iC7 drive to the Studio 5000 Logix Designer® project, after all files are installed and the hardware catalog in the Studio

5000® is updated

6. In the Studio 5000 Logix Designer® application, click File ⇒ New in the drop-down menu to create a new project.

The following example is based on a Compact GuardLogix® CPU. The following series can also be used:

¢ CompactLogix®.

¢ ControlLogix®.

¢ GuardLogix®.
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Figure 4: Create a New Project

7. In the menu project types, click the [Logix] icon, and select the corresponding controller in the drop-down menu.
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Figure 5: Selection of the Controller

8. Enter the name of the project and click the [Next] button.

9. Select the corresponding revision of the firmware for the corresponding CPU.

Using the latest available revision or update to the latest revision from Rockwell Automation® is recommended.
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Figure 6: Selection of Firmware Revision

10. Click the [Finish] button to complete the configuration of the CPU.

The new project opens in Studio 5000 Logix Designer®.

11. Unfold the menu in the controller organizer window and select the Ethernet I/P of the controller.

12. Right-click the Ethernet I/P and select New Module.
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Figure 7: Adding a New Module

13. A new Select Module Type window opens, see Figure 8.

14. Select the field filter and type the text iC7.

This selects the catalog number for the iC7 drive only, with Industry application or Motion application.

NOTE: More applications become visible in the upcoming releases of the iC7 series products.
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15. Select the corresponding application installed in the iC7 drive and click the [Create] button.
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Figure 8: Select Module Type

16. A New Module window opens.

17. Select General in the menu and type the name for the iC7 drive in the project, see Figure 9.

18. Enter the same IP address from MyDrive® Insight or from the control panel of the iC7 drive.

Refer to appendix 7.1 Change the IP Address Settings from MyDrive® Insight for further information of how to change the

IP address settings from MyDrive® Insight.

19. Click the [OK] button to accept the new module.

The default connection assembly instance is EO 100/150. Click the [Change] button to change the connection assembly

instance. Refer to the operating guide iC7 Series EtherNet/IP OS7IP for further information of difference connection instances

supported by the iC7 drive.
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Figure 9: New Module

20. Check that the iC7 drive is visible in the controller organizer window in the folder I/O Configuration.
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Figure 10: iC7 Automation Drive Added in I/O Configuration Menu

21. The corresponding I/O tags are automatically created for the connection instance selected.

Figure 11 show the I/O tags for the connection assembly instance 100/150. There are 4 bytes (SINT-Short Integer) available

in each direction (In and Out), corresponding to the STW, MAV, CTW, and REF. From this point, the motor can be controlled

using the iC-Speed profile with default settings.
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Figure 11: I/O Tags for Connection Assembly Instance

22. Select the common settings for the connection instance to change the profile if required. Change the value (101=iC-Speed

profile).

Refer to the operating guide iC7 Series EtherNet/IP OS7IP for further information of the profile selection.

NOTE: The add-on instruction and add-on graphic in this application guideline is only supporting the iC-

Speed profile.
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Figure 12: Change Fieldbus Profile

3.3 Changing Process Data (Optional)
If another assembly instance is selected, for example EO 130/180, additional process data can be configured directly from Studio 5000

Logix Designer®. The following example shows how to assign additional process data based on assembly instance 130/150 (80 bytes IN

and 80 bytes OUT).

NOTE: Each process data occupies 4 bytes of data, regardless of the data type of each process data. A process data can

be configured as a Boolean (1 bit) to a Real (32 bit) value. The programmer must control the data type and the amount of

data used for each process data.

1. Open the window Module Properties Local for the iC7 drive.

2. Click the [Change] button.
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Figure 13: Module Properties Local

3. The Module Definition opens in a new window.

4. Select the field Name to open the drop-down menu. See Figure 14.

5. Select, for example, the assembly instance EO 130/180 in the drop-down menu.
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Figure 14: Module Definition

6. In the field Data Type, a [Change ] button is visible.
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Figure 15: Data Type Field

7. Click the [Change] button for the input (read process data).

A customizable process data array with a capacity of 20 process data opens.
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Figure 16: Custom Data Type (Read Process Data)

8. The available data from the iC7 drive can be mapped into the array for each process data field.

A Maximum of 20 process data can be mapped. See Figure 17 for an example of mapped process data in the input

direction.
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Figure 17: Example of Mapped Process Data (Input)

9. Click the [OK] button when the required process data in the input direction is configured.

The Custom Data Type window closes.

10. Click the [Change] button for the output (write) process data, see Figure 15.

A customizable process data array with a capacity of 20 process data open. See Figure 18 for an example of mapped

process data in the output direction.
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Figure 18: Example of Mapped Process Data (Output)

11. Click the [OK] button when the requested process data in the output direction is configured.

The Custom Data Type window closes.

12. Click the [OK] button in the Module Definition window when the process data in both directions are defined.

13. A warning message opens. Click the [Yes] button to accept the changes to the module definition of the iC7 drive.
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Figure 19: Change the Module Definition of the iC7 Drive

14. The Module Properties window for the iC7 drive reopens if Yes is selected.
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Figure 20: Apply the New Module Properties

15. Click the [Apply] and [OK] buttons.

16. Check that the new process data tags for the input and output are visible in the Controller Tags window.
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Figure 21: Input and Output Process Data Tags

17. Select the field Size in the Module Definition window to change the tag data type.

The data type for each tag is visible in the Module Definition window.
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NOTE: Optional. Only perform this procedure if a change of the tag data type is required.
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Figure 22: Change of Tag Data Type
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4 Add-on Instruction

4.1 Define Add-on Instruction
The following steps explain how to add an add-on instruction for drives in the Studio 5000 Logix Designer®.

Add-on instructions are predefined programs or functions contained within a single program element that can be used in the PLC

program. The add-on instruction is written in ladder language and opens for further extensions or adjustments if required by the end-

user.

A basic motor control and monitoring add-on instruction are available for download on the Danfoss web portal, refer to VLT®, VACON®,

and iC7 PLC Libraries | Danfoss.

NOTE: Only I/O connections assembly instance 100/150 is supported for the basic add-on instruction, to get the iC7 drive

operational.

1. Download the file iC7_Basic_AOI.L5X from the Danfoss web portal.

2. Navigate to the Controller Organizer window.

Start with the creation of a new main routine is recommended.

3. Select the folder Tasks in the drop-down menu.

4. Right-click the MainProgram and select Add ⇒ New Routine.
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Figure 23: Creation of New Main Routine

5. A new window New Routine open.

6. Enter the name of the routine in the field Name and click the [OK] button.

The new routine is visible under the MainRoutine.
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Figure 24: Example of New Routine

7. In the Controller Organizer window, select the folder Assets in the drop-down menu. See Figure 25.

8. Right-click the Add-On Instructions and select Import Add-On Instruction.
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Figure 25: Import Add-on Instruction

9. A new window Import Add-On Instruction open.

10. Select the AOI file iC7_Basic_AOI.L5X and click the [Open] button.
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Figure 26: Select Import File

11. A new window Import Configuration - iC7_Basic_AOI.L5X opens, see Figure 27.

12. Click the [OK] button to start the import of the AOI.

It is possible to change the field Final Name  and the field Description in the add-on instruction properties if necessary.
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Figure 27: Start the Import of the AOI File

13. Check that the corresponding add-on instructions Logic, User-Defined types and Add-On Defined block become visible as shown

in Figure 28.
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Figure 28: Import of AOI File Completed
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14. The add-on instruction is now located in the element group and can be added to a rung in the newly created routine. Select the

add-on instruction in the Language Element  bar in the Studio 5000 Logix Designer®.
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Figure 29: Language Element Bar

15. Drag-drop the logic element iC7_Basic add-on instruction to the rung.

The block is visible in the rung as shown in the example Figure 30.
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Figure 30: Adding Logic Element to Rung

16. Create tags for each element in the block, to configure the iC7_ Basic add-on instruction block.

It is possible to create either local or global tags. The following example shows local tags only.

17. Select the folder Tasks in the drop-down menu, and open the Parameter and Local Tags see Figure 31.

18. Select the tab Edit Tags.
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Figure 31: Program Parameters and Local Tags

19. In the field Name, type in for example Motor_1 and open the field Data Type and select the iC7_Basic. Click the [OK] button to

accept the change.

All required data definition and data types for this instance of the add-on instruction are automatically created with this

tag.
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Figure 32: Create a Local Tag (Example)

20. Select the new created tag as the operand for the add-on instruction block and select the [Enter] button on the keyboard.

Danfoss A/S © 2024.12                                                                                                                                                                        AB501135116041en-000101 / 136R0371 | 27



e3
0b

m
08

7.
10

Figure 33: Select Tag as Operand

21. Select the corresponding tags from the controller tags table and add this to the block as shown in Figure 34 for the Data_IN and

Data_OUT.

The Data_IN and Data_OUT operands are the I/O assembly instances from the drive, which is created as tag information

as controller tags. The Data_IN tag selected here is the connection assembly instance 150 and the Data_OUT is the

connection assembly instance 100.

Data_IN Data_OUT
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Figure 34: Adding Controller Tags Table to the Block

22. If the configuration is successfully completed, it must look similar as the example, see Figure 35.
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Figure 35: Configuration of the Block Completed

23. Open MainRoutine and add a call to the new routine using a jump to subroutine (JSR) command. Find the command in the

Program Control Elements  section.

24. Enter the corresponding subroutine in the element where the iC7 add-on instruction is located, and delete other instruction

parameters in the element.
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Figure 36: Execute the New Created Routine

25. Click the icon [Verify Controller] and check that the output is without any errors or warnings.
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Figure 37: Verify Controller

26. Select the Controller Status and click [Download] in the drop-down menu.

NOTE: It is possible that the connection from Studio 5000® already is established. Alternatively, select the Go

Online and accept to download the program to the controller when the information message appears.

It is possible that a Studio 5000® connection is already established.
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Figure 38: Download the Program to Controller

27. The controller allows online access for monitoring and modifying add-on instruction tags after program download.
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Figure 39: Change or Monitor Tags
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4.1.1 Definition of I/O Data

Table 2: Definition of I/O Data

Input/
output

I/O data
definition

Data type Description

IC7_Basic UDT Instance tag for the add-on instruction.

COAST_INV Bool Coast stop inverse. If false, this will coast the motor.

RUN Bool Motor start/stop. If true, the motor will start/run. If false, the motor performs a ramp
stop.

NOTE: This function depends on index 5.8.6.2.x Ramp 1 settings.

REVERSE Bool Reverse the motor direction. If true, the motor starts spinning in the reverse direction.

Q_STOP Bool Quick stop. If true, perform a quick stop ramp.

NOTE: This function is depending on index 5.7.3.x Quick stop settings
(1).

RESET Bool Reset an occurrence. If true, a present fault can be reset, if the conditions for the reset
of the fault/faults are met.

NOTE: Fault acknowledge (reset). 0 ⇒ 1=Acknowledge faults. Acknowledging is edge

triggered, when changing from logic 0 to logic 1. 0 = No function.

Input

REF_VALUE Real Added value gives the reference value in percentage based on N2 definition (-200% -
+200%).

NOTE: Note: Only 0–200% is possible due to the reverse function. This function

depends on the index 5.8.3.x Speed limits
(1).

READY Bool If true, the motor is ready to start and run. If false, the motor cannot start, since the
raised conditions for a start command are not fulfilled.

NOTE: Refer to section 6.1 Troubleshooting with the Basic Drive Function Block for

clarification on root-cause finding for missing start condition.

FAULT Bool If true, a fault/alarm is present, and the motor is stopped. If false, the drive is fully op-
erational.

WARNING Bool If true, a warning is present, but it is still possible to control the motor, maybe with
limited performance. If false, no warning is present, and the motor is fully operational.

RUNNING Bool The motor is started and is heading or performing the requested reference value.

RUN_ON_REF Bool The main actual value matches the requested reference value.

Output

MAV Real The estimated rotor speed of the motor is controlled in open-loop conditions.

NOTE: The value depends on index 4.3.4.x settings
(1).

1) The index number and name depends on the current application installed in the iC7drive. The number in the table is valid for iC7-Automation with Industry Application installed.
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5 Add-on Graphic

5.1 Define Add-on Graphics
The add-on instruction is support by a corresponding faceplate, named add-on graphics (AOG) in Studio 5000®. The add-on graphic is

fully compatible with the add-on instruction. The following example shows how to implement the add-on graphic in Studio 5000 View

Designer®.

1. Open the Studio 5000 View Designer®.

2. Select Create ⇒ New Project.

3. Open the desired HMI panel for editing.

Figure 40 is an example of a new project with the 6.5" PanelView 5510 selected. The entered name is My_HMI_Panel and the

selected version is 9, which corresponds to the firmware installed in the Allen-Bradley® PanelView™ HMI Panel.

4. Enter the name of the project in the field Name.

Name in this example (My_HMI_Panel).

5. Check the corresponding version of the firmware of the HMI panel.

Version in this example (Version 9).

6. Click the [Finish] button.
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Figure 40: New Project

7. A new window Project Properties open.
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8. Define the interface configuration from the HMI panel to the controller.

¢ Controller[0] Reference Name:

n A unique name assigned for the controller reference. For example, MyController.

¢ Logix Project File:

n Studio 5000 Logix Designer® project file, where the add-on instruction is located. In the example, the selected
ACD (Application Code Definition) file is the one selected from the previous section MyFirstProject_iC7.ACD.

¢ HMI to Controller Path:

n Path where the controller is located. In the example, the IP address 192.168.0.10, slot 0 of the Compact
GuardLogix® setup.

¢ Emulator to Controller Path:

n If no real HMI panel exists, select the emulator path where the controller is located. The HMI panel can then be
emulated from the Studio 5000 View Designer® environment.
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Figure 41: Interface Configuration from HMI Panel to Controller

9. Click the [OK] or [Apply] button when all the entries are created and selected.

The default screen becomes visible in Studio 5000 View Designer®. The 1st user-defined screen (Screen_001)  is visible, and

it is now possible to design the HMI application as required.

5.1.1 Working with the Add-on Graphic

1. Open the View Designer and select File ⇒ Import Project.

Before using the add-on graphical faceplate in the Studio 5000 View Designer® tool, it must be imported.
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Figure 42: Import Project

2. Find the location of the downloaded add-on graphic file.

In this example iC7 Rockwell > AOG > iC7_Basic_Template, see Figure 43.

3. Select the ViewApplication.hmi file and click the [Open] button.

The import of the add-on graphic starts.
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Figure 43: Import Add-on Graphic
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4. A message appears when all items for the add-on graphic are correctly imported. Click the [OK] button to complete the import.
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Figure 44: Add-on Graphic Imported Successfully

NOTE: Project Properties should be checked and corrected after import, since the properties will be overwritten

by the tool after the import function has been executed.
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5. Open the Project Explorer window from the Studio 5000 View Designer®.
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Figure 45: Project Explorer Window

6. Select Assets ⇒ Add-On Graphics in the drop-down menu, and check that 1 new element iC7_Basic is added.

7. Select User-Defined Screens in the drop-down menu and check that 2 new elements Motors and Popup_Motor_1 are added.

8. Select Assets ⇒ Add-On Graphics ⇒ iC7_Basic right-click and open.

9. Add the user-defined type iC7-Basic from the add-on instruction in the Property Definition.

The link to the add-on instruction in the Studio 5000 Logix Designer® project is a precondition.
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Figure 46: Adding User-defined Type File

10. The add-on graphic screen can be closed after the UDT is selected as the data type.

11. Open the user-defined screen Motors and select the text field Motor name.

In the  Properties window of the selection, the binding to the instance of the given function block of the add-on instruction

must be provided.

12. In Properties ⇒ General ⇒ Text, click the 3 dots to open the selection window.
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In the example, the instance of the function block is identified as Motor_1.

NOTE: This is only valid if the variables are local. If global variables are used, the path looks different.
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Figure 47: User-Defined Screen Properties (Motors)

13. Select the @Name attribute for the given function block. Close the user-defined screen.

14. Open the user-defined screen Popup_Motor_1.

15. In the Properties ⇒ General ⇒ iC7_Basic click the 3 dots to open the selection window.
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Figure 48: User-Defined Screen Properties (Popup_Motor_1)

16. Select the name Motor_1 to get the linking enabled from the instance of the add-on instruction function block. Close the user-

defined screen.

17. Click the [Verify ] icon to verify the project.

Save the project frequently is recommended. Click the [Disk] icon on the menu bar to save the project.
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Figure 49: Verify the Project

18. The verified project must be without any errors or warnings.
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Figure 50: Project Verified Message

19. In the Project Explorer, select the drop-down menu on the folder User-Defined Screens.

20. Right-click the file Motors and select New Shortcut in the drop-down menu.

A new screen with the name Motors appears in the Navigation Menu in Project Explorer.
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Figure 51: Shortcut of the Motors File

21. Right-click the new screen Motors and select Set as Home in the drop-down menu.
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Figure 52: Set the New Screen as Home

22. Click the [Emulate] button on the menu bar to emulate the project.

Alternatively, the project can be downloaded to a real HMI panel if present. Click the [Download current application to

selected HMI device] button, located next to the [Emulate] button. In this example, the [Emulate] button is used.
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Figure 53: Emulate the Project

23. When the emulator is started, the defined home screen appears.

The name of the motor appears as the given name in the instance of the add-on instruction function block. When selecting

the motor, the add-on graphic faceplate appears for the specific motor.
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Figure 54: Defined Home Screen

24. From the add-on graphic faceplate, it is possible to control and monitor the motor controlled by the iC7 drive.
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Figure 55: Add-on Graphic Face Plate Default Settings

1 Enable/disable motor control.
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Figure 56: Add-on Graphic Face Plate for the Specific Motor

1 The green rectangular shape around the button [Start]
[ indicates that the motor is ready to start. The [Start]
button can be selected.

2 SP (Set-Point) specifies the speed reference (REF).

3 PV (Process-Value) specifies the main actual value
(MAV) of the motor speed.

25. When the reference speed is reaching the main actual value speed, a green rectangular shape appears around the value field SP.

This indicates that the motor is on-reference target.
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Figure 57: On-reference Target

26. Close the add-on graphic on the cross in the upper right corner.

Adjust the size and shape of the add-on graphic faceplate in the Studio 5000 View Designer® to fit any HMI panel of the

PanelView™ 5000 series.
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6 Troubleshooting

6.1 Troubleshooting with the Basic Drive Function Block

The following flow chart can be used for troubleshooting with the basic drive function block.
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 = True
       ?

No
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              ?
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Figure 58: Troubleshooting with the Basic Drive Function Block
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7 Appendix

7.1 Change the IP Address Settings from MyDrive® Insight
IPv4 settings are configured in MyDrive® Insight.

1. Open MyDrive® Insight.

The IP address settings for the interface X1/X2 are available in the menu folder 10 Connectivity, see Figure 59.

2. Open the drop-down menu 10 Connectivity ⇒ 10.2.3 Ethernet Interface X1/X2 Settings.

3. Select the submenu IPv4 Settings.
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Figure 59: Ethernet Interface X1/X2 Settings

4. This example shows a manually entered static IP address for simplicity.

IP address settings can also be configured automatically from a DHCP server (Automatic, default setting).
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Figure 60: IP Configuration of the Interface
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5. Click the [Apply] button in the lower right corner after the IP address is changed.
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Figure 61: Apply the IP Address Settings

6. Open the submenu IPv4 Status to verify the new configured IP address settings.
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Figure 62: Verify the Configured IP Address Settings

7. Open the menu 10.3 Protocols ⇒ 10.3.4 Ethernet/IP ⇒ 10.3.4.1 Status.

8. Select the Ethernet/IP Report to view the connection status from the EtherNet/IP status report in MyDrive® Insight.

View the connection status when the connection between the controller and the iC7 drive is established. The report

provides a static data snapshot and does not update automatically. Update the report to view the latest data.
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Figure 63: EtherNet/IP Status Report
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